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Question Number : 1 Question Id : 2549896610 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which feature of Windows 11 allows the desktop backgrounds to change automatically after some specified time interval?
Options :
1.  Slideshow
2.  Gadget
3.  Aero theme
4.  Jump list
   
Question Number : 1 Question Id : 2549896610 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
Windows 11 का कौन-सा फीचर डेस्कटॉप बैकग्राउंड को कु छ निर्दिष्ट समय अंतराल के  बाद, स्वचालित रूप से बदलने की सुविधा देता है?
Options :
1.  स्लाइडशो (Slideshow)

2.  गैजेट (Gadget)

3.  एयरो थीम (Aero theme)

4.  जम्‍प लिस्ट (Jump list)
   
Question Number : 2 Question Id : 2549896614 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Each cell of a memory device is capable of storing one bit of information in the form of binary numbers. What does the term 'bit' mean?
Options :
1.  Binary digit
2.  Binary divisor
3.  Bidirectional digit
4.  Bidirectional divisor
   
Question Number : 2 Question Id : 2549896614 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
मेमोरी डिवाइस का प्रत्येक सेल बाइनरी संख्याओं के  रूप में एक बिट इन्फोर्मेशन संग्रहीत करने में सक्षम है। शब्द 'बिट (bit)' का अर्थ क्या है?
Options :
1.  बाइनरी अंक (Binary digit)

2.  बाइनरी भाजक (Binary divisor)

3.  द्विदिश अंक (Bidirectional digit)

4.  द्विदिश भाजक (Bidirectional divisor)
   
Question Number : 3 Question Id : 2549897553 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
UNIVAC is a ________ generation computer.
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Options :
1.  first
2.  second
3.  third
4.  fourth
   
Question Number : 3 Question Id : 2549897553 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
यूनिवैक (UNIVAC) एक ________ पीढ़ी का कं प्यूटर है।
Options :
1.  पहली
2.  दू सरी
3.  तीसरी
4.  चौथी
   
Question Number : 4 Question Id : 2549898342 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS Excel 2019, the _______ function returns the number of characters of a text string.
Options :
1.  LEN
2.  CONCATENATE
3.  FIND
4.  COUNT
   
Question Number : 4 Question Id : 2549898342 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS EXCEL 2019 में, _______ फ़ं क्शन टेक्स्ट स्ट्रिं ग के  वर्णों की संख्या प्रदान करता है।
Options :
1.  LEN
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2.  CONCATENATE
3.  FIND
4.  COUNT
   
Question Number : 5 Question Id : 2549898571 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which function key is used for style and formatting data in OpenOffice Writer?
Options :
1.  F11
2.  F6
3.  F9
4.  F7
   
Question Number : 5 Question Id : 2549898571 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ओपन ऑफिस राइटर (OpenOffice Writer) में कौन-सी फं क्शन कुं जी स्टाइल और फॉर्मेटिंग डेटा के  लिए उपयोग की जाती है?
Options :
1.  F11
2.  F6
3.  F9
4.  F7
   
Question Number : 6 Question Id : 2549898973 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following languages is used to write web pages?
Options :
1.  HTML
2.  Machine language
3.  Fortran
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4.  Cobol
   
Question Number : 6 Question Id : 2549898973 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
वेब पेजों को राइट करने के  लिए इनमें से किस भाषा का उपयोग किया जाता है?
Options :
1.  HTML

2.  मशीन भाषा (Machine language)

3.  फोरट्रा न (Fortran)

4.  कोबोल (Cobol)
   
Question Number : 7 Question Id : 2549899181 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following terms is used for the transmission of electronic messages over the internet?
Options :
1.  E-mail
2.  ISP
3.  E-commerce
4.  Login
   
Question Number : 7 Question Id : 2549899181 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन-सा शब्द इंटरनेट पर इलेक्ट्रॉ निक संदेशों के  प्रसारण के  लिए उपयोग किया जाता है?
Options :
1.  ई-मेल (E-mail)

2.  आईएसपी (ISP)

3.  ई-कॉमर्स (E-commerce)

4.  लॉगिन (Login)
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Question Number : 8 Question Id : 2549899372 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What does 'CD-RW' in 'CD-RW disk' stand for?
Options :
1.  Compact Disc-Rewritable
2.  Compact Disc-Recordable
3.  Compact Disc-ROM
4.  Compact Disc-Rotate
   
Question Number : 8 Question Id : 2549899372 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'CD-RW डिस्क' में 'CD-RW' का क्या अर्थ है?
Options :
1.  Compact Disc-Rewritable (कॉम्पैक्ट डिस्क-रीराईटेबल)

2.  Compact Disc-Recordable (कॉम्पैक्ट डिस्क-रिकॉर्डेबल)

3.  Compact Disc-ROM (कॉम्पैक्ट डिस्क-रोम)

4.  Compact Disc-Rotate (कॉम्पैक्ट डिस्क-रोटेट)
   
Question Number : 9 Question Id : 25498910944 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A ____________ refers to a physical or digital template that acts as a barrier, allowing ink to pass through only specific areas onto the printing surface.
Options :
1.  stencil
2.  layer
3.  mask
4.  spot
   
Question Number : 9 Question Id : 25498910944 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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____________ एक भौतिक या डिजिटल टेम्पलेट को संदर्भित करता है जो एक अवरोधक के  रूप में कार्य करता है, जिससे स्याही को मुद्रण सतह पर के वल विशिष्ट क्षेत्रों से
गुजरने दिया जाता है।
Options :
1.  स्टैंसिल (stencil)

2.  लेयर (layer)

3.  मास्क (mask)

4.  स्पॉट (spot)
   
Question Number : 10 Question Id : 25498911243 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a place where email is received and managed?
Options :
1.  Inbox
2.  Trash
3.  Spam
4.  Sent mail
   
Question Number : 10 Question Id : 25498911243 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ई-मेल निम्न में से किस स्थान पर प्राप्त और प्रबंधित होते हैं?
Options :
1.  इनबॉक्स (Inbox)

2.  ट्रै श (Trash)

3.  स्पैम (Spam)

4.  सेंट मेल (Sent mail)
   
Question Number : 11 Question Id : 25498911594 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A ______ is used to read handwritten or printed text to make a digital image that can be stored in memory.
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Options :
1.  scanner
2.  printer
3.  screen
4.  touch pad
   
Question Number : 11 Question Id : 25498911594 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ का उपयोग हस्तलिखित या मुद्रित टेक्स्ट को पढ़कर डिजिटल इमेज बनाने के  लिए किया जाता है जिसे मेमोरी में संग्रहीत किया जा सकता है।
Options :
1.  स्‍कै नर (scanner)

2.  प्रिंटर (printer)

3.  स्क्रीन (screen)

4.  टच पैड (touch pad)
   
Question Number : 12 Question Id : 25498913537 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a text, like contact information or a favourite quote, that’s automatically added at the end of Gmail messages as a footer?
Options :
1.  signature
2.  subject
3.  formatting option
4.  attachment
   
Question Number : 12 Question Id : 25498913537 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन-सा टेक्स्ट, जैसे संपर्क  जानकारी या पसंदीदा उद्धरण, Gmail संदेशों के  अंत में फ़ु टर के  रूप में स्वचालित रूप से जुड़ जाता है?
Options :
1.  सिग्नेचर (signature)
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2.  सब्जेक्ट (subject)

3.  फ़ॉर्मेटिंग ऑप्शन (formatting option)

4.  अटैचमेंट (attachment)
   
Question Number : 13 Question Id : 25498913583 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Google Docs offers a large collection of special characters. To insert a special character in Google Docs, which of the following options is used?
Options :
1.  Insert
2.  Tools
3.  Add-ons
4.  Format
   
Question Number : 13 Question Id : 25498913583 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Google Docs विशेष वर्णों का एक बड़ा संग्रह प्रदान करता है। Google Docs में, विशेष वर्ण इन्सर्ट करने के  लिए, निम्न में से किस विकल्प का उपयोग किया जाता है?
Options :
1.  इन्सर्ट (Insert)

2.  टू ल्स (Tools)

3.  ऐड-ऑन्स (Add-ons)

4.  फ़ॉर्मेट (Format)
   
Question Number : 14 Question Id : 25498913638 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a popular internet messaging service used around the world as an alternative to text messages, phone calls and more?
Options :
1.  WhatsApp
2.  Google Maps
3.  Atlas
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4.  Google Docs
   
Question Number : 14 Question Id : 25498913638 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन-सी एक लोकप्रिय इंटरनेट संदेश सेवा है जिसका उपयोग दुनिया भर में टेक्स्ट मैसेज, फोन कॉल आदि के  विकल्प के  रूप में किया जाता है?
Options :
1.  व्हाट्सप्प (WhatsApp)

2.  गूगल मैप्स (Google Maps)

3.  एटलस (Atlas)

4.  गूगल डॉक्स (Google Docs)
   
Question Number : 15 Question Id : 25498919101 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The easiest and most convenient way to find and install software in Ubuntu Linux is:
Options :
1.  Ubuntu Software Center
2.  Ubuntu desktop
3.  Ubuntu guide
4.  Ubuntu Applications
   
Question Number : 15 Question Id : 25498919101 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
उबन्टू  (Ubuntu) लिनक्स में सॉफ़्टवेयर फाइंड और इंस्टॉल करने का सबसे आसान और सुविधाजनक तरीका कौन-सा है?
Options :
1.  उबन्टू  सॉफ्टवेयर सेंटर (Ubuntu Software Center)

2.  उबन्टू  डेस्कटॉप (Ubuntu desktop)

3.  उबन्टू  गाइड (Ubuntu guide)

4.  उबन्टू  एप्लिके शन्स (Ubuntu Applications)
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Question Number : 16 Question Id : 25498919456 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the frequency used by Wi-Fi radios for transmissions ?
Options :
1.  2.4 GHz or 5 GHz
2.  3 GHz or 8 GHz
3.  2 GHz or 7.3 GHz
4.  3 GHz or 7 GHz
   
Question Number : 16 Question Id : 25498919456 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
प्रसारण के  लिए वाई-फाई रे डियो द्वारा उपयोग की जाने वाली आवृत्ति क्या होती है?
Options :
1.  2.4 GHz या 5 GHz

2.  3 GHz या 8 GHz

3.  2 GHz या 7.3 GHz

4.  3 GHz या 7 GHz
   
Question Number : 17 Question Id : 25498920645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What would one use for immediate, real-time communication with a friend?
Options :
1.  Instant Messaging
2.  E-mail
3.  Usenet
4.  Blog
   
Question Number : 17 Question Id : 25498920645 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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एक मित्र के  साथ तत्काल, वास्तविक समय संचार हेतु आप क्या उपयोग करेंगे?
Options :
1.  इंस्टेंट मैसेजिंग (Instant Messaging)

2.  ई-मेल (E-mail)

3.  यूज़नेट (Usenet)

4.  ब्लॉग (Blog)
   
Question Number : 18 Question Id : 25498922028 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The simplest way to mark the authenticity of a message is by computing its ____.
Options :
1.  checksum
2.  parity
3.  redundancy
4.  length
   
Question Number : 18 Question Id : 25498922028 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
संदेश की प्रामाणिकता को चिह्नित करने का सबसे आसान तरीका इसकी ____ की गणना करना है।
Options :
1.  चेकसम (Checksum)

2.  समानता (Parity)

3.  अतिरेकता (Redundancy)

4.  लंबाई (Length)
   
Question Number : 19 Question Id : 25498922619 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the difference between impact and non-impact printers?
Options :
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1.  Impact printers make straight physical contact with paper.
2.  Impact printers are quicker as compared to non-impact printers.
3.  Impact printers produce better quality.
4.  Impact printers are smoother than non-impact printers.
   
Question Number : 19 Question Id : 25498922619 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
इंपैक्ट और नॉन-इंपैक्ट प्रिंटरों में क्या अंतर है?
Options :
1.  इंपैक्ट प्रिंटर पेपर के  साथ प्रत्यक्ष भौतिक संपर्क  बनाते हैं।
2.  नॉन-इंपैक्ट प्रिंटरों की तुलना में इंपैक्ट प्रिंटर तेज़ी के  काम करते हैं।
3.  इंपैक्ट प्रिंटर के  मुद्रण की गुणवत्ता बेहतर होती है।
4.  नॉन-इंपैक्ट प्रिंटरों की तुलना में इंपैक्ट प्रिंटर अधिक सुचारू रूप से काम करते हैं।
   
Question Number : 20 Question Id : 25498922716 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Your laptop turns on without displaying any image on the screen. After a few seconds, it shuts down by itself, then turns on and off repeatedly. What could be
the problem?
Options :
1.  Faulty power supply
2.  Printer problem
3.  Ethernet card problem
4.  Sound card problem
   
Question Number : 20 Question Id : 25498922716 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
आपका लैपटॉप चालू होता है लेकिन स्क्रीन पर कोई इमेज नहीं  दिखाता। कु छ सेकं ड बाद यह अपने आप बंद हो जाता है, फिर बार-बार चालू और बंद होता रहता है। समस्या
क्या हो सकती है?
Options :
1.  ख़राब पावर सप्लाई
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2.  प्रिंटर की खराबी
3.  ईथरनेट कार्ड की खराबी
4.  साउंड कार्ड की खराबी
   
Question Number : 21 Question Id : 25498923813 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following types of memory is at the top of the memory hierarchy and provides the fastest way for a CPU to access data?
Options :
1.  Register memory
2.  RAM
3.  ROM
4.  Hard Disk
   
Question Number : 21 Question Id : 25498923813 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्न में से किस प्रकार की मेमोरी, मेमोरी पदानुक्रम (hierarchy) में शीर्ष पर आती है और सीपीयू को डेटा एक्सेस करने हेतु सबसे तेज़ तरीका प्रदान करती है?
Options :
1.  रजिस्टर मेमोरी (Register memory)

2.  RAM (रैम)

3.  ROM (रॉम)

4.  हार्ड डिस्क (Hard Disk)
   
Question Number : 22 Question Id : 25498923954 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS Word 2019, the 'Resize' icon on the table appears at the _________ corner of the table.
Options :
1.  lower-right
2.  lower-left
3.  upper-left
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4.  upper-right
   
Question Number : 22 Question Id : 25498923954 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 में टेबल पर 'रीसाइज़ (Resize)' आइकन टेबल के  _________ कोने पर दिखाई देता है।
Options :
1.  निचले दाएं  (lower-right)

2.  निचले बाएं  (lower-left)

3.  ऊपरी बाएं  (upper-left)

4.  ऊपरी दाएं  (upper-right)
   
Question Number : 23 Question Id : 25498923955 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Pressing the 'Backspace' key in MS Word deletes the character immediately to the ________ of the insertion point.
Options :
1.  Left
2.  Right
3.  Below
4.  Above
   
Question Number : 23 Question Id : 25498923955 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
 MS-Word में ‘बैकस्पेस (Backspace)' कुं जी को दबाने पर, इन्सर्शन पॉइंट के  ________ का वर्ण तुरंत डिलीट हो जाता है।
Options :
1.  बाएँ  
2.  दाएँ
3.  नीचे
4.  ऊपर
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Question Number : 24 Question Id : 25498923962 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In which E-governance model is information transmitted to a wider public domain through the use of ICT and convergent media?
Options :
1.  Broadcasting model
2.  Interactive model
3.  Critical flow model
4.  Interactive service model
   
Question Number : 24 Question Id : 25498923962 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
किस ई-गवर्नेंस मॉडल में सूचना को आईसीटी और अभिसारी मीडिया के  उपयोग के  माध्यम से व्यापक सार्वजनिक डोमेन में प्रेषित किया जाता है?
Options :
1.  ब्रॉडकास्टिंग मॉडल (Broadcasting model)

2.  इंटरै क्टिव मॉडल (Interactive model)

3.  क्रिटिकल फलो मॉडल (Critical flow model)

4.  इंटरै क्टिव सर्विस मॉडल (Interactive service model)
   
Question Number : 25 Question Id : 25498923963 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is an example of comparative analysis model in E-governance?
Options :
1.  Dashboards displaying key performance indicators
2.  Emergency alert systems
3.  Government websites that publish notices
4.  Online petition platforms
   
Question Number : 25 Question Id : 25498923963 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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निम्नलिखित में से कौन सा ई-गवर्नेंस में तुलनात्मक विश्लेषण मॉडल का एक उदाहरण है?
Options :
1.  मुख्य प्रदर्शन संके तक प्रदर्शित करने वाले डैशबोर्ड
2.  आपातकालीन चेतावनी प्रणालियाँ
3.  सूचनाएँ  प्रकाशित करने वाली सरकारी वेबसाइटें
4.  ऑनलाइन याचिका प्लेटफ़ॉर्म
   
Question Number : 26 Question Id : 25498923972 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ is the direct computer-to-computer exchange between two business partners (e.g., a manufacturer of finished goods and a supplier of raw materials) of
standard business documents such as purchase orders and invoices.
Options :
1.  Electronic Data Interchange
2.  Digital Wallets
3.  Smart cards
4.  SIM cards
   
Question Number : 26 Question Id : 25498923972 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______ दो व्यावसायिक भागीदारों (जैसे, तैयार माल का निर्माता और कच्चे माल का आपूर्तिकर्ता) के  बीच खरीद आदेश और चालान जैसे मानक व्यापार दस्तावेजों के  बीच सीधा
कं प्यूटर-टू -कं प्यूटर एक्सचेंज है।
Options :
1.  इलेक्ट्रॉ निक डेटा के  आदान प्रदान (Electronic Data Interchange)

2.  डिजिटल वॉलेट्स (Digital Wallets)

3.  स्मार्ट कार्ड्स (Smart cards)

4.  सिम कार्ड्स (SIM cards)
   
Question Number : 27 Question Id : 25498923974 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a valid 'font style' in MS-Word 2019?
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Options :
1.  Non-regular
2.  Italics
3.  Bold
4.  Small cap
   
Question Number : 27 Question Id : 25498923974 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 में, निम्न में से कौन-सी एक मान्य/वैध 'फ़ॉन्ट शैली (font style)' नहीं  है?
Options :
1.  नॉन-रेग्युलर (Non-regular)

2.  इटैलिक (Italics)

3.  बोल्ड (Bold)

4.  स्माल कै प (Small cap)
   
Question Number : 28 Question Id : 25498924000 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts is used in a Windows 10 system to switch between open apps?
Options :
1.  Alt + Tab
2.  Ctrl + Tab
3.  Alt + N
4.  Ctrl + N
   
Question Number : 28 Question Id : 25498924000 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
विंडोज़ 10 सिस्टम में खुली (ओपन) ऐप्स के  बीच स्विच करने के  लिए निम्न में से कौन-से कीबोर्ड शॉर्टकट का उपयोग किया जाता है?
Options :
1.  Alt + Tab
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2.  Ctrl + Tab
3.  Alt + N
4.  Ctrl + N
   
Question Number : 29 Question Id : 25498924468 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The Microsoft Spartan browser was included in the first technical builds of _______, released in early 2015.
Options :
1.  Windows 10
2.  Windows 8
3.  Windows 7
4.  Windows 2000
   
Question Number : 29 Question Id : 25498924468 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
माइक्रोसॉफ्ट स्पार्टन ब्राउज़र को 2015 की शुरुआत में जारी _______ के  पहले तकनीकी बिल्ड में शामिल किया गया था।
Options :
1.  Windows 10
2.  Windows 8
3.  Windows 7
4.  Windows 2000
   
Question Number : 30 Question Id : 25498924514 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A file with a .cpp extension is associated with which of the following programming languages?
Options :
1.  C++
2.  C
3.  C#
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4.  CC
   
Question Number : 30 Question Id : 25498924514 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
.cpp एक्सटेंशन वाली फ़ाइल निम्नलिखित में से किस प्रोग्रामिंग भाषा से संबंधित है?
Options :
1.  C++
2.  C
3.  C#
4.  CC
   
Question Number : 31 Question Id : 25498924610 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
An Adobe Frame Maker document uses which of the following extensions?
Options :
1.  FM
2.  AFM
3.  FMS
4.  FMD
   
Question Number : 31 Question Id : 25498924610 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एडोब फ्रे म मेकर डॉक्यूमेंट में निम्न में से किस एक्सटेंशन का उपयोग किया जाता है?
Options :
1.  FM
2.  AFM
3.  FMS
4.  FMD
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Question Number : 32 Question Id : 25498925254 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The length of an IPV6 address is _____________.
Options :
1.  128 bits
2.  265 bits
3.  64 bits
4.  32 bits
   
Question Number : 32 Question Id : 25498925254 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
IPv6 एड्रे स की लंबाई _____________ है।
Options :
1.  128 बिट्स
2.  265 बिट्स
3.  64 बिट्स
4.  32 बिट्स
   
Question Number : 33 Question Id : 25498925255 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
DHCP stands for:
Options :
1.  Dynamic Host Configuration Protocol
2.  Dynamic Hyper Configuration Protocol
3.  Dynamic Hyper Control Protocol
4.  Dynamic Host Control Protocol
   
Question Number : 33 Question Id : 25498925255 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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DHCP का पूर्ण रूप क्या है?
Options :
1.  Dynamic Host Configuration Protocol (डाइनामिक होस्ट कॉन्फिगरेशन प्रोटोकॉल)

2.  Dynamic Hyper Configuration Protocol (डाइनामिक हाइपर कॉन्फ़िगरेशन प्रोटोकॉल)

3.  Dynamic Hyper Control Protocol (डाइनामिक हाइपर कं ट्रो ल प्रोटोकॉल)

4.  Dynamic Host Control Protocol (डाइनामिक होस्ट कं ट्रो ल प्रोटोकॉल)
   
Question Number : 34 Question Id : 25498925449 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A username on X (formerly known as Twitter) is also referred to as a __________.
Options :
1.  handle
2.  target
3.  summary
4.  guide
   
Question Number : 34 Question Id : 25498925449 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
X (जिसे पहले ट्विटर के  नाम से जाना जाता था) पर उपयोगकर्ता नाम को __________ के  रूप में भी संदर्भित किया जाता है।
Options :
1.  हैंडल (handle)

2.  टार्गेट (target)

3.  समरी (summary)

4.  गाइड (guide)
   
Question Number : 35 Question Id : 25498930027 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is correct?
Options :
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1.  Both SRAM and DRAM are random access memory.
2.  SRAM is a non-volatile memory.
3.  DRAM is faster than SRAM.
4.  SRAM requires periodic refreshing.
   
Question Number : 35 Question Id : 25498930027 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित कथनों में से कौन-सा सही है?
Options :
1.  SRAM और DRAM, दोनों ही रैंडम एक्सेस मेमोरी हैं।
2.  SRAM एक नॉन-वोलेटाइल मेमोरी है।
3.  DRAM, SRAM से तेज होती है।
4.  SRAM को समय-समय पर रिफ्रे शिंग की आवश्यकता होती है।
   
Question Number : 36 Question Id : 25498930333 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following Blu-ray disks can be erased and recorded multiple times?
Options :
1.  BD-RE
2.  BD
3.  BD-R
4.  Both BD and BD-R
   
Question Number : 36 Question Id : 25498930333 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन-सी ब्लू-रे  डिस्क के  कं टेट को मिटाया जा सकता है और कई बार रिकॉर्ड किया जा सकता है?
Options :
1.  BD-RE
2.  BD
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3.  BD-R

4.  BD और BD-R दोनों
   
Question Number : 37 Question Id : 25498930438 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following techniques does the internet use?
Options :
1.  Packet switching
2.  Circle switching
3.  Hybrid switching
4.  Line switching
   
Question Number : 37 Question Id : 25498930438 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
इंटरनेट में किस तकनीक का उपयोग किया जाता है?
Options :
1.  पैके ट स्विचिंग (Packet switching)

2.  सर्क ल स्विचिंग (Circle switching)

3.  हाइब्रिड स्विचिंग (Hybrid switching)

4.  लाइन स्विचिंग (Line switching)
   
Question Number : 38 Question Id : 25498931242 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In the early days of computers, KIPS (Kilo Instructions Per Second) was used to measure the execution speed of a:
Options :
1.  processor
2.  disk drive
3.  printer
4.  tape drive
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Question Number : 38 Question Id : 25498931242 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कं प्यूटर के  शुरुआती दिनों में, KIPS (किलो इंस्ट्र क्शन प्रति सेकं ड) का उपयोग ________ की निष्पादन की गति को मापने के  लिए किया जाता था।
Options :
1.  प्रोसेसर (processor)

2.  डिस्क ड्रा इव (disk drive)

3.  प्रिंटर (printer)

4.  टेप ड्रा इव (tape drive)
   
Question Number : 39 Question Id : 25498931244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In which generation of computers was the 'transistor' introduced?
Options :
1.  2nd Generation
2.  1st Generation
3.  3rd Generation
4.  4th Generation
   
Question Number : 39 Question Id : 25498931244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कं प्यूटर की किस पीढ़ी में पहली बार 'ट्रां जिस्टर' का उपयोग हुआ था?
Options :
1.  दू सरी पीढ़ी
2.  पहली पीढ़ी
3.  तीसरी पीढ़ी
4.  चौथी पीढ़ी
   
Question Number : 40 Question Id : 25498932171 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
The internet service that provides audio and video conversation is called ______.
Options :
1.  video conferencing
2.  chat
3.  email
4.  message
   
Question Number : 40 Question Id : 25498932171 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
ऑडियो और वीडियो बातचीत (संचार) की सुविधा देने वाली इंटरनेट सेवा ______ कहलाती है।
Options :
1.  वीडियो कॉन्फ्रे न्सिंग (video conferencing)

2.  चैट (chat)

3.  ईमेल (email)

4.  मैसेज (message)
   
Question Number : 41 Question Id : 25498932893 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_________ is a non-volatile memory in which data can be written only once. Once data is written, it is permanent and cannot be erased.
Options :
1.  PROM
2.  EEPROM
3.  SRAM
4.  EPROM
   
Question Number : 41 Question Id : 25498932893 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
_________ एक नॉन-वोलेटाइल मेमोरी है जिसमें डेटा के वल एक बार ही राइट किया जा सकता है, और एक बार डेटा राइट हो जाने के  बाद यह स्थायी हो जाता है, इसे मिटाया
नहीं  जा सकता है।
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Options :
1.  PROM
2.  EEPROM
3.  SRAM
4.  EPROM
   
Question Number : 42 Question Id : 25498938506 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following options refers to the amount of data a CPU's internal data registers can hold and process at one time?
Options :
1.  Word size
2.  ROM size
3.  RAM size
4.  Cache size
   
Question Number : 42 Question Id : 25498938506 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन-सा विकल्प एक सीपीयू के  आंतरिक डेटा रजिस्टरों द्वारा एक समय में रखे और संसाधित किए जा सकने वाले डेटा की मात्रा को संदर्भित करता है?
Options :
1.  वर्ड साइज़ (Word size)

2.  रॉम साइज़ (ROM size)

3.  रैम साइज़ (RAM size)

4.  कै श साइज़ (Cache size)
   
Question Number : 43 Question Id : 25498940620 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts is used to move the cursor up by one paragraph in MS-Word 2019?
Options :
1.  Ctrl + Up arrow key
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2.  Ctrl + Down arrow key
3.  Ctrl + Right arrow key
4.  Ctrl + Left arrow key
   
Question Number : 43 Question Id : 25498940620 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 में कर्सर को एक पैराग्राफ ऊपर ले जाने के  लिए निम्नलिखित में से किस कीबोर्ड शॉर्टकट का उपयोग किया जाता है?
Options :
1.  Ctrl + Up arrow key (अप एरो की)
2.  Ctrl + Down arrow key (डाउन एरो की)
3.  Ctrl + Right arrow key (राइट एरो की)
4.  Ctrl + Left arrow key (लेफ्ट एरो की)
   
Question Number : 44 Question Id : 25498943121 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS-Excel 2019, the _____ function finds a value in a single row or column and matches it with a value in the same position in a second row or column.
Options :
1.  LOOKUP
2.  Sort
3.  Filter
4.  LOOK
   
Question Number : 44 Question Id : 25498943121 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में, _____ फ़ं क्शन एक पंक्ति या स्तंभ में एक मान ढूं ढता है और इसे दू सरी पंक्ति या स्तंभ में समान स्थिति में मान के  साथ मिलाता है।
Options :
1.  LOOKUP (लुकअप)

2.  Sort (सॉर्ट)
3.  Filter (फ़िल्टर)
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4.  LOOK (लुक)
   
Question Number : 45 Question Id : 25498943124 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Consider the given table in MS Excel 2019 and determine which of the following must be used to find the average of all commissions less than 23000. Three of
the four commissions meet this condition, and their total is 42000.

Options :
1.  =AVERAGEIF(B2:B5, “<23000”)
2.  =AVERAGEIF(A2:A5, ”>250000”, B2:B5)
3.  =AVERAGE(A2:A5, ”>250000”, B2:B5)
4.  =AVERAGE(B2:B5, “<23000”)
   
Question Number : 45 Question Id : 25498943124 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में दी गई तालिका पर विचार करें  और निर्धारित करें  कि 23000 से कम सभी कमीशनों का औसत ज्ञात करने के  लिए निम्नलिखित में से किसका उपयोग किया
जाना चाहिए। चार में से तीन कमीशन इस शर्त को पूरा करते हैं, और उनका कु ल योग 42000 है।
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Options :
1.  =AVERAGEIF(B2:B5, “<23000”)
2.  =AVERAGEIF(A2:A5, ”>250000”, B2:B5)
3.  =AVERAGE(A2:A5, ”>250000”, B2:B5)
4.  =AVERAGE(B2:B5, “<23000”)
   
Question Number : 46 Question Id : 25498943146 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The ____ function is one of the most popular functions in MS-Excel 2019 that allows you to make logical comparisons between a value and what you expect.
Options :
1.  IF
2.  MATCH
3.  COMPARE
4.  LOOK
   
Question Number : 46 Question Id : 25498943146 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में, ___________ फ़ं क्शन सबसे लोकप्रिय फं क्शन में से एक है और यह आपको किसी मान और आपकी अपेक्षा के  बीच तार्कि क तुलना करने की सुविधा देता
है।
Options :
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1.  इफ (IF)

2.  मैच (MATCH)

3.  कमपेअर (COMPARE)

4.  लुक (LOOK)
   
Question Number : 47 Question Id : 25498943149 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS Excel 2019, ________ refers to an input box directly to the left of the formula bar. It normally displays the address of the ‘active cell’ on the worksheet.
Options :
1.  Name Box
2.  Formula
3.  Goal seek
4.  Auto fill
   
Question Number : 47 Question Id : 25498943149 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS Excel 2019 में, ________, फॉर्मूला बार के  बाईं ओर स्थित एक इनपुट बॉक्स को संदर्भित करता है। यह आमतौर पर वर्क शीट पर 'सक्रिय सेल' का पता प्रदर्शित करता है।
Options :
1.  नेम बॉक्स (Name Box)

2.  फॉर्मूला (Formula)

3.  गोल सीक (Goal seek)

4.  ऑटो फिल (Auto fill)
   
Question Number : 48 Question Id : 25498943166 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A group of cells in MS-Excel 2019 is called:
Options :
1.  cell range
2.  cell address
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3.  cell
4.  group
   
Question Number : 48 Question Id : 25498943166 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में सेलों के  समूह को __________ कहा जाता है।
Options :
1.  सेल रेंज (cell range)

2.  सेल एड्रे स (cell address)

3.  सेल (cell)

4.  ग्रुप (group)
   
Question Number : 49 Question Id : 25498943169 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following option is used to record a macro in MS-Excel 2019?
Options :
1.  Developer → Record Macro
2.  Insert → Macro
3.  Home → Macro
4.  Insert → Options → Developer
   
Question Number : 49 Question Id : 25498943169 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में मैक्रो रिकॉर्ड करने के  लिए निम्नलिखित में से किस विकल्प का उपयोग किया जाता है?
Options :
1.  Developer → Record Macro (डेवलपर → रिकॉर्ड मैक्रो)
2.  Insert → Macro (इन्सर्ट → मैक्रो)
3.  Home → Macro (होम → मैक्रो)
4.  Insert → Options → Developer (इन्सर्ट → ऑप्शन्स → डेवलपर)
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Question Number : 50 Question Id : 25498943189 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
__________ sorts the selected column in an ascending order in MS-Excel 2019.
Options :
1.  Sort A to Z
2.  Format A to Z
3.  Filter A to Z
4.  Custom list A to Z
   
Question Number : 50 Question Id : 25498943189 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
____________ MS Excel 2019 में चयनित कॉलम के  डेटा को आरोही क्रम में सॉर्ट करता है।
Options :
1.  Sort A to Z (सॉर्ट A टू  Z)

2.  Format A to Z (फॉर्मेट A टू  Z)

3.  Filter A to Z (फ़िल्टर A टू  Z)

4.  Custom list A to Z (कस्टम लिस्ट A टू  Z)
   
Question Number : 51 Question Id : 25498943191 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ will keep the leftmost column visible when you scroll horizontally in MS-Excel 2019.
Options :
1.  Freeze first column
2.  Freeze first row
3.  Lock first row
4.  Lock first column
   
Question Number : 51 Question Id : 25498943191 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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MS-Excel 2019 में, जब आप क्षैतिज रूप से स्क्रॉल करते हैं, तो ________ सबसे बाएं  कॉलम को प्रदर्शित/दृश्यमान रखेगा।
Options :
1.  Freeze first column (फ्रीज फर्स्ट कॉलम)

2.  Freeze first row (फ्रीज फर्स्ट रो)
3.  Lock first row (लॉक फर्स्ट रो)
4.  Lock first column (लॉक फर्स्ट कॉलम)
   
Question Number : 52 Question Id : 25498943194 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following options will enable you to resize a table in MS Excel 2019?
Options :
1.  Table Design  → Resize Table
2.  Insert → Resize
3.  File → Resize
4.  View → Resize
   
Question Number : 52 Question Id : 25498943194 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन-सा विकल्प आपको MS Excel 2019 में तालिका का आकार बदलने में सक्षम करेगा?
Options :
1.  Table Design → Resize Table (टेबल डिज़ाइन → रीसाइज टेबल)

2.  Insert → Resize (इन्सर्ट → रीसाइज)

3.  File → Resize (फ़ाइल → रीसाइज)

4.  View → Resize (व्यू → रीसाइज)
   
   

READING COMPREHENSION
Section Id : 2549899834
Section Number : 2
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Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 5
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549899875
Question Shuffling Allowed : No
Is Section Default? : No
   
Question Id : 25498921721 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension Questions : No
Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
Read the given passage and answer the questions that follow.

Fear casts its shadow over our lives at one time or another. Neither the highest nor the lowest of us is exempt from fear. Fear is the one mark that characterises
us, children of a sceptical age. We are afraid of the future, afraid of poverty, afraid of unemployment, afraid of dishonour and disgrace, afraid of disease, and
death----sometimes we are afraid of life itself!
"Nothing in life is to be feared; it is only to be understood", said Marie Curie.

Do you wish to overcome your fears and phobias? If you really want it then you can do it. When you do this, you achieve a remarkable victory that can change
your life. The victory is not the prerogative of the holy, the mighty and the brave. All of us have the potential to achieve it.

The first step in conquering fear is to become aware that fear is removable. Very often there is no ‘logic’ in fear. I know some people who are terrified of
contracting a major illness… but they are even more scared to meet a specialist and go through a series of tests. There are many old people who are terrified of
the long, lonely years that lie ahead of them, haunted by the fear of death! We are afraid to die and we are afraid to live, because life has become so complicated,
risky and insecure!

‘A ship in harbour is safe’ goes the saying. But that is not what ships are built for!
Sub questions
 
Question Number : 53 Question Id : 25498921722 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which fear is NOT mentioned in this passage?
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Options :
1.  Fear of failure
2.  Fear of death
3.  Fear of dishonour
4.  Fear of life
 
Question Number : 54 Question Id : 25498921723 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
According to the passage, the first step in overcoming fear is _____________________.
Options :
1.  recognising that it can be removed
2.  praying for God’s help
3.  seeking the support of the powerful
4.  appealing to holy people
 
Question Number : 55 Question Id : 25498921724 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
According to the passage, there is no logic in fear because it makes us:
Options :
1.  do the opposite of what we ought to do
2.  terrified of falling sick
3.  scared of a lonely future
4.  afraid of life but unafraid of death
 
Question Number : 56 Question Id : 25498921725 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Victory over fear is possible for:
Options :
1.  all those who are willing to try
2.  the brave and the mighty
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3.  holy people
4.  the old and the weak
 
Question Number : 57 Question Id : 25498921726 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What does the quotation about the ship mean?
Options :
1.  Risks have to be taken in life
2.  Ships must be kept in safe places
3.  Those who are afraid must stay away from ships
4.  Ships must stay out of danger during storms

   
Question Id : 25498921721 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension Questions : No Question
Pattern Type : NonMatrix
Question Numbers : (53 to 57)
दिए गए गद्यांश को पढ़िए और उसके  बाद आने वाले प्रश्नों के  उत्तर दीजिए।

डर कभी न कभी हमारे  जीवन पर अपनी छाया डालता है। बड़े से बड़ा और छोटे से छोटा, हममें से कोई भी डर से अछू ता नहीं  है। डर ही वह एक लक्षण है जो हम जैसे संशयी उम्र
के  बच्चों की पहचान है। हम भविष्य से डरते हैं, गरीबी से डरते हैं, बेरोजगारी से डरते हैं, अपमान और बदनामी से डरते हैं, बीमारी से डरते हैं, और मौत से डरते हैं---- कभी-कभी
तो हम जीवन से ही डर जाते हैं! "जीवन में किसी भी चीज से डरना नहीं  चाहिए; बल्कि उसे के वल जानना-समझना चाहिए।" मैरी क्यूरी ने कहा था।

क्या आप अपने डर और भय (फोबिया) से उबरना चाहते हैं?  यदि आप वास्तव में ऐसा चाहते हैं, तो आप ऐसा कर भी सकते हैं। जब आप ऐसा करते हैं, तो आप एक असाधारण
जीत प्राप्त करते हैं जो आपके  जीवन को बदल सकती है। जीत पर के वल परम-पवित्र, सर्वशक्तिमान और बहादुर लोगों का ही विशेषाधिकार नहीं  है। हम सभी में इसे प्राप्त करने
की क्षमता है।

डर पर विजय पाने का पहला कदम यह जानना है कि डर को दू र किया जा सकता है। अक्सर डर में कोई 'तर्क ' नहीं  होता है। मैं कु छ ऐसे लोगों को जानता हूँ जो किसी बड़ी बीमारी
से घबराते हैं... लेकिन वे किसी विशेषज्ञ से मिलने और कई तरह की जाँच करवाने से और भी ज़्यादा डरते हैं।

ऐसे कई वृद्ध इंसान हैं जो अपने भविष्य में आने वाले लंबे, एकांतिक वर्षों से डरते रहे हैं, मौत के  डर से त्रस्त हैं!

हम मरने से डरते हैं और हम जीने से भी डरते हैं, क्योंकि जीवन बहुत जटिल, जोखिमभरा और असुरक्षित हो गया है!

"बंदरगाह में जहाज सुरक्षित होता है", ऐसा कहा जाता है, लेकिन जहाज बंदरगाह में खड़े रहने के  लिए तो नहीं  बनाए गए हैं!
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Sub questions
 
Question Number : 53 Question Id : 25498921722 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
इस गद्यांश में किस डर का उल्लेख नहीं  किया गया है?
Options :
1.  असफलता का डर
2.  मृत्यु का डर
3.  अपमान का डर
4.  जीवन का डर
 
Question Number : 54 Question Id : 25498921723 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
गद्यांश के  अनुसार, डर पर जीत प्राप्‍त करने का पहला कदम क्या है?
Options :
1.  यह स्वीकार कर लेना कि इसे मिटाया जा सकता है
2.  ईश्वर से मदद के  लिए प्रार्थना करना
3.  शक्तिशाली लोगों का समर्थन प्राप्त करना
4.  पवित्र व्यक्तियों से अनुरोध करना
 
Question Number : 55 Question Id : 25498921724 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
गद्यांश के  अनुसार, डर का कोई औचित्य नहीं  है क्योंकि यह _________।
Options :
1.  हमें जो करना चाहिए उसके  विपरीत कार्य करने के  लिए प्रेरित करता है
2.  हमें बीमार पड़ने से भयभीत करता है
3.  हमें एकाकी भविष्य से डराता है
4.  हमें जीवन से तो भयभीत करता है लेकिन मृत्यु से नहीं
 
Question Number : 56 Question Id : 25498921725 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes

TypingWale  ·  Type karo. Seekho. Exam clear karo. Hindi Typing Software

  Free Try karo  ·  typingwale.com  

Follow us on:
YT X FB IG WA

https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper
https://www.youtube.com/@CPCTwale
https://x.com/CPCTwale
https://www.facebook.com/cpctwale
https://www.instagram.com/cpctwale/
https://whatsapp.com/channel/0029Vb76AhmAu3aOqnzcYE0y
https://typingwale.com/?utm_source=CPCT&utm_medium=CPCT+PDF&utm_campaign=CPCT+PYQ+Paper


Correct Marks : 1 Wrong Marks : 0
डर पर विजय कौन प्राप्त कर सकता है?
Options :
1.  कोशिश करने वाला प्रत्‍येक व्‍यक्ति
2.  बहादुर और शक्तिशाली व्‍यक्ति
3.  पवित्र व्यक्ति
4.  बूढ़े  और कमजोर व्‍यक्ति
 
Question Number : 57 Question Id : 25498921726 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जहाज के  बारे  में दिए गए उद्धरण का अर्थ क्या है?
Options :
1.  जीवन में जोखिम उठाना चाहिए
2.  जहाजों को सुरक्षित स्थान पर रखा जाना चाहिए
3.  जो लोग डरते हैं उन्हें जहाजों से दू र रहना चाहिए
4.  जहाजों को तूफान के  दौरान खतरे  से बाहर रहना चाहिए

        QUANTITATIVE APTITUDESection Id : 2549899835Section Number : 3Section type : OnlineMandatory or Optional :
MandatoryNumber of Questions : 6Number of Questions to be attempted : 6Section Marks : 6Display Number Panel : YesMaximum Instruction Time :
0Sub-Section Number : 1Sub-Section Id : 2549899876Question Shuffling Allowed : YesIs Section Default? : No    
Question Number : 58 Question Id : 25498928868 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Train A crosses a stationary Train B in 50 seconds and a pole in 20 seconds at the same speed. The length of Train A is 240 metres. What is the length of the
stationary Train B?
Options :
1.  360 metres
2.  260 metres
3.  300 metres
4.  Cannot be determined

   
Question Number : 58 Question Id : 25498928868 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
ट्रे न A एक खड़ी ट्रे न B को 50 सेकं ड में और एक खंभे को 20 सेकं ड में समान गति से पार करती है। ट्रे न A की लंबाई 240 मीटर है। खड़ी ट्रे न B की लंबाई कितनी है?
Options :
1.  360 मीटर 

2.  260 मीटर 

3.  300 मीटर 

4.  निर्धारित नहीं  की जा सकती है
   
Question Number : 59 Question Id : 25498929020 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A starts a business by investing ₹28,000. After 2 months B joins with ₹20,000, and after another two months C joins with ₹18,000. At the end of 10 months from
the start of the business if B withdraws ₹2,000 and C withdraws ₹2,000, in what ratio should the profit be distributed among A, B and C at the end of the year?
Options :
1.  12 : 7 : 5
2.  12 : 9 : 5
3.  12 : 6 : 3
4.  14 : 7 : 5

   
Question Number : 59 Question Id : 25498929020 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A,₹28,000 का निवेश करके  एक व्यवसाय शुरू करता है। 2 महीने बाद, B व्यवसाय में ₹20,000 निवेश करके  इसमें शामिल हो जाता है, और अगले दो महीने बाद,
C व्यवसाय में ₹18,000 निवेश करके  इसमें शामिल हो जाता है। व्यवसाय शुरू होने के  10 महीने बाद, यदि B, ₹2,000 और C,
₹2,000 निकाल लेता है, तो वर्ष के  अंत में, लाभ को A, B और C के  बीच किस अनुपात में वितरित किया जाना चाहिए?
Options :
1.  12 : 7 : 5
2.  12 : 9 : 5
3.  12 : 6 : 3
4.  14 : 7 : 5

   
Question Number : 60 Question Id : 25498929046 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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A person has to travel from point A to point B in a certain time. Travelling at a speed of 5 km/h he reaches 48 minutes late and travelling at a speed of 8 km/h he
reaches 15 minutes early. What is the distance between points A and B?
Options :
1.  14 km
2.  15 km
3.  9 km
4.  12 km

   
Question Number : 60 Question Id : 25498929046 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक व्यक्ति को बिंदु A से बिंदु B तक एक निश्चित समय में यात्रा करनी है। 5 किमी/घंटा की गति से यात्रा करते हुए वह 48 मिनट देरी से पहुँचता है और 8 किमी/घंटा की गति से यात्रा
करते हुए वह 15 मिनट पहले पहुँचता है। बिंदु A और B के  बीच की दू री कितनी है?
Options :
1.  14 किमी
2.  15 किमी
3.  9 किमी
4.  12 किमी

   
Question Number : 61 Question Id : 25498929149 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :
1.  ₹16,000
2.  ₹6,000
3.  ₹14,440
4.  ₹9,200

   
Question Number : 61 Question Id : 25498929149 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Options :
1.  ₹16,000
2.  ₹6,000
3.  ₹14,440
4.  ₹9,200

   
Question Number : 62 Question Id : 25498929674 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
By how much above the cost should the goods be marked for sale so that after allowing a trade discount of 25% and then a cash discount of 10%, a net gain of 20%
on the cost is made?
Options :

1.  

2.  55%
3.  75%

4.  

   
Question Number : 62 Question Id : 25498929674 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
माल की बिक्री के  लिए उस पर लागत मूल्य से कितना अधिक मूल्य अंकित किया जाना चाहिए ताकि 25% की व्यापार छू ट और फिर 10% की नकद छू ट देने के  बाद, लागत मूल्य
पर 20% का शुद्ध लाभ प्राप्त हो?
Options :

1.  

2.  55%
3.  75%
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4.  

   
Question Number : 63 Question Id : 25498929683 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

Options :
1.  15
2.  12
3.  18
4.  20

   
Question Number : 63 Question Id : 25498929683 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0

 
Options :
1.  15
2.  12
3.  18
4.  20

        GENERAL MENTAL ABILITY AND REASONINGSection Id : 2549899836Section Number : 4Section type :
OnlineMandatory or Optional : MandatoryNumber of Questions : 6Number of Questions to be attempted : 6Section Marks : 6Display Number Panel :
YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-Section Id : 2549899877Question Shuffling Allowed : YesIs Section Default? : No    
Question Number : 64 Question Id : 25498910273 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
All 30 students in a class are standing in a row facing the north. Ravi is 15th from the right end while Bhavya is 8th from the left end. How many students stand
between Ravi and Bhavya?
Options :
1.  7
2.  6
3.  8
4.  9

   
Question Number : 64 Question Id : 25498910273 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक कक्षा के  सभी 30 विद्यार्थी उत्तर दिशा की ओर अभिमुख होकर एक पंक्ति में खड़े हैं। रवि दाएँ  छोर से 15वें स्थान पर है जबकि भव्या बाएँ  छोर से 8वें स्थान पर है। रवि और भव्या
के  बीच कितने विद्यार्थी खड़े हैं?
Options :
1.  7
2.  6
3.  8
4.  9

   
Question Number : 65 Question Id : 25498914091 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Jumbled letters of a meaningful word are given below. Rearrange these letters and select from the given alternatives the word which is almost similar in meaning to
the rearranged word.

P R S D I T U
Options :
1.  Break
2.  Deny
3.  Refuse
4.  Join

   
Question Number : 65 Question Id : 25498914091 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
नीचे एक सार्थक शब्द के  अक्षर अव्यवस्थित क्रम अक्षर में दिए गए हैं। इन अक्षरों को पुनर्व्यवस्थित करने पर बनने वाले सार्थक शब्द के  समानार्थी शब्द का चयन विकल्पों में से
कीजिए।

P R S D I T U
Options :
1.  Break
2.  Deny
3.  Refuse
4.  Join

   
Question Number : 66 Question Id : 25498919864 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Five friends P, R, V, X and Y are of different heights. Only Y is taller than R. V is taller than P but shorter than X. How many people are taller than V?
Options :
1.  Three
2.  None
3.  One
4.  Two

   
Question Number : 66 Question Id : 25498919864 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
पाँच मित्र P, R, V, X और Y की ऊँ चाई अलग-अलग है। के वल Y, R से लंबा है। V, P से लंबा है लेकिन X से नाटा है। V से कितने व्यक्ति लंबे हैं?
Options :
1.  तीन
2.  एक भी नहीं
3.  एक
4.  दो

   
Question Number : 67 Question Id : 25498927409 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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Select the correct mirror image of the given figure when the mirror is placed at MN as shown below.

Options :

1.  
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2.  

3.  

4.  

   
Question Number : 67 Question Id : 25498927409 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
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दी गई आकृ ति की सही दर्पण प्रतिबिंब का चयन करें  जब नीचे दिखाए अनुसार दर्पण को MN के  अनुदिश रखा गया हो।

Options :

1.  
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2.  

3.  

4.  

   
Question Number : 68 Question Id : 25498928204 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Seven people, R, S, T, U, V, W and X are sitting in a row, facing the north. Exactly two people sit to the right of S. R sits second to the right of S. Exactly four
people sit between V and R. W is an immediate neighbour of both T and S. U sits to the immediate right of S. Who among them sits third to the right of X?
Options :
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1.  W
2.  T
3.  U
4.  V

   
Question Number : 68 Question Id : 25498928204 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
सात व्यक्ति, R, S, T, U, V, W और X, एक पंक्ति में उत्तर दिशा की ओर अभिमुख होकर बैठे  हैं। S के  दाईं ओर के वल दो व्यक्ति बैठे  हैं। R, S के  दाईं ओर दू सरे  स्थान पर बैठा है।
V और R के  बीच के वल चार व्यक्ति बैठे  हैं। T और S दोनों का निकटतम पड़ोसी W है। U, S के  ठीक दाईं ओर पड़ोस में बैठा है। उनमें से कौन X के  दाईं ओर तीसरे  स्थान पर बैठा
है?
Options :
1.  W
2.  T
3.  U
4.  V

   
Question Number : 69 Question Id : 25498928708 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Four letter-clusters have been given, out of which three are alike in some manner and one is different. Select the one that is different.
Options :
1.  HIKLO
2.  BCDEI
3.  PQRSW
4.  LMNOS

   
Question Number : 69 Question Id : 25498928708 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
विकल्पों में चार अक्षर-समूह दिए गए हैं उनमें से तीन किसी तरीके  से संगत हैं जबकि कोई एक उनसे असंगत है। असंगत अक्षर-समूह का चयन कीजिए।
Options :
1.  HIKLO
2.  BCDEI
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3.  PQRSW
4.  LMNOS

        GENERAL AWARENESSSection Id : 2549899837Section Number : 5Section type : OnlineMandatory or Optional : MandatoryNumber of
Questions : 6Number of Questions to be attempted : 6Section Marks : 6Display Number Panel : YesMaximum Instruction Time : 0Sub-Section Number :
1Sub-Section Id : 2549899878Question Shuffling Allowed : YesIs Section Default? : No    
Question Number : 70 Question Id : 2549895837 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The Caves and Rock Cut Temples of Ellora are of which religious origin?
Options :
1.  Hindu, Buddhist and Jain
2.  Hindu and Buddhist
3.  Buddhist and Jain
4.  Hindu and Jain

   
Question Number : 70 Question Id : 2549895837 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
गुफाओं और चट्टानों को काट कर बनाये गये एलोरा के  मंदिर किस धार्मिक मूल के  हैं?
Options :
1.  हिंदू , बौद्ध और जैन
2.  हिंदू  और बौद्ध
3.  बौद्ध और जैन
4.  हिंदू  और जैन

   
Question Number : 71 Question Id : 25498912804 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Where was 2008 Paralympic Games held?
Options :
1.  Beijing
2.  Paris
3.  Tokyo
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4.  London
   
Question Number : 71 Question Id : 25498912804 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
2008 पैरालंपिक खेल का आयोजन कहाँ किया गया था?
Options :
1.  बीजिंग
2.  पेरिस
3.  टोक्यो
4.  लंदन

   
Question Number : 72 Question Id : 25498932072 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Mallika Sarabhai is associated with which of the following fields?
Options :
1.  Classical dance
2.  Social service
3.  Classical music
4.  Sports

   
Question Number : 72 Question Id : 25498932072 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
मल्लिका साराभाई निम्नलिखित में से किस क्षेत्र से संबंधित हैं?
Options :
1.  शास्त्रीय नृत्य
2.  समाज सेवा
3.  शास्त्रीय संगीत
4.  खेल

   
Question Number : 73 Question Id : 25498935422 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
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Correct Marks : 1 Wrong Marks : 0
The National Stock Exchange of India Limited (NSE) commenced trading in derivatives with the launch of index futures on June 12, _________________.
Options :
1.  2000
2.  1999
3.  2001
4.  2004

   
Question Number : 73 Question Id : 25498935422 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नेशनल स्टॉक एक्सचेंज ऑफ इंडिया लिमिटेड (NSE) ने 12 जून, _________ को इंडेक्स फ्यूचर्स के  लॉन्च के  साथ डेरिवेटिव में ट्रे  डिंग शुरू की।
Options :
1.  2000
2.  1999
3.  2001
4.  2004

   
Question Number : 74 Question Id : 25498935652 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What phenomenon is responsible for the splitting of white light into its constituent colours when it passes through a glass prism?
Options :
1.  Dispersion
2.  Reflection
3.  Refraction
4.  Diffraction

   
Question Number : 74 Question Id : 25498935652 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब श्वेत प्रकाश कांच के  प्रिज्म से गुजरता है तो किस घटना के  कारण वह अपने घटक रंगों में विभाजित होता है?
Options :
1.  परिक्षेपण (Dispersion)
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2.  परावर्तन (Reflection)

3.  अपवर्तन (Refraction)

4.  विवर्तन (Diffraction)
   
Question Number : 75 Question Id : 25498935700 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is correct in the context of Money Bill?
Options :
1.  Money Bill is introduced in Lok Sabha.
2.  Money Bill is introduced in Rajya Sabha.
3.  It can be introduced in either of the Houses of the Parliament.
4.  It cannot be introduced in Lok Sabha.

   
Question Number : 75 Question Id : 25498935700 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
मनी बिल के  संदर्भ में निम्न कथनों में से कौन-सा सही है?
Options :
1.  धन विधेयक लोकसभा में पेश किया जाता है।
2.  धन विधेयक राज्यसभा में पेश किया जाता है।
3.  इसे संसद के  किसी भी सदन में पेश किया जा सकता है।
4.  इसे लोकसभा में पेश नहीं  किया जा सकता है।

        English MockGroup Number : 2Group Id : 2549896084Group Maximum Duration : 5Group Minimum Duration : 5Show Attended Group? :

NoEdit Attended Group? : NoBreak time : 1Mandatory Break time : YesGroup Marks : 0         English MockSection Id : 2549899838Section
Number : 1Section type : Typing TestMandatory or Optional : MandatoryNumber of Questions : 1Number of Questions to be attempted : 1Section Marks :
0Display Number Panel : YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-Section Id : 2549899879Question Shuffling Allowed : NoIs Section
Default? : Yes    
Question Number : 76 Question Id : 25498940961 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork, socializing, decision
making, independent and responsible living and more. It aids the overall development of a child and children have fun during this process as they get to
explore new arenas.
Restricted/ Unrestricted : Unrestricted
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Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes

        English ActualGroup Number : 3Group Id : 2549896085Group Maximum Duration : 15Group Minimum Duration : 15Show Attended Group?

: NoEdit Attended Group? : NoBreak time : 3Mandatory Break time : YesGroup Marks : 0         English Typing TestSection Id :
2549899839Section Number : 1Section type : Typing TestMandatory or Optional : MandatoryNumber of Questions : 1Number of Questions to be attempted
: 1Section Marks : 0Display Number Panel : YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-Section Id : 2549899880Question Shuffling
Allowed : NoIs Section Default? : Yes    
Question Number : 77 Question Id : 25498943012 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Tsunami is a Japanese word that is made of two characters tsu and nami. The character tsu means harbor while the character nami means wave.
Therefore the original word tsunami describes large wave oscillations inside a harbor during a tsunami event. In the past tsunami is often referred to as
tidal wave which is a misnomer. Tides featuring the rising and falling of water level in the ocean in a daily monthly and yearly cycle are caused by
gravitational influences of the moon sun and planets. Tsunamis are not generated by this kind of gravitational forces and are unrelated to the tides
although the tidal level does influence a tsunami striking a coastal area. The phenomenon we call a tsunami is a series of water waves of extremely long
wavelength and long period generated in an ocean by a geophysical disturbance that displaces the water within a short period of time. Waves are formed
as the displaced water mass which acts under the influence of gravity attempts to regain its equilibrium. Tsunamis are primarily associated with
submarine earthquakes in oceanic and coastal regions. Tsunamis are characterised as shallow water waves or long waves which are different from wind
generated waves the waves many of us have observed on a beach. The initial amplitude of a tsunami in the vicinity of a source region is usually quite small
typically only a meter or less in comparison with the wavelength. In general as the tsunami propagates into the open ocean the amplitude of tsunami will
decrease for the wave energy is spread over a much larger area. In the open ocean it is very difficult to detect a tsunami from aboard a ship because the
water level will rise only slightly over a period of ten minutes to hours. Since the rate at which a wave loses its energy is inversely proportional to its
wavelength a tsunami will lose little energy as it propagates. Hence in the open ocean a tsunami will travel at high speeds and over great transoceanic
distances with little energy loss. As a tsunami propagates into shallower waters near the coast it undergoes a rapid transformation. Because the energy loss
remains insignificant the total energy flux of the tsunami which is proportional to the product of the square of the wave amplitude and the speed of the
tsunami remains constant. Therefore the speed of the tsunami decreases as it enters shallower water and the height of the tsunami grows. Studies on
tsunami sedimentology have revealed that tsunamis induce various types of sedimentation in marine lacustrine and onshore environments. Tsunami
deposits are sedimentological evidence of tsunami events. This contribution describes the nature of tsunamis and of tsunami sedimentation as an
introduction to this volume. Hydrodynamic aspects are introduced to explain the propagation of tsunamis. The diversity of tsunami deposits is illustrated
on the basis of literature data. Onshore tsunami sedimentation is discussed in particular. Tsunami sedimentation appears to depend on the hydrodynamic
and hydraulic character of the tsunami. The distribution pattern grain size variation and many other sedimentological structures reflect the characters of
the tsunami such as the height current velocity and period. Therefore tsunami sedimentation should be interpreted based on careful consideration of the
characteristics of tsunamis. This may result in a reliable reconstruction of ancient tsunami events.
Restricted/ Unrestricted : Unrestricted
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Paragraph Display : Yes
Keyboard Layout : Inscript
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes

        Hindi MockGroup Number : 4Group Id : 2549896086Group Maximum Duration : 10Group Minimum Duration : 10Show Attended Group? :

NoEdit Attended Group? : NoBreak time : 5Mandatory Break time : YesGroup Marks : 0         Hindi MockSection Id : 2549899840Section Number :
1Section type : Typing TestMandatory or Optional : MandatoryNumber of Questions : 1Number of Questions to be attempted : 1Section Marks : 0Display
Number Panel : YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-Section Id : 2549899881Question Shuffling Allowed : NoIs Section Default?
: Yes    
Question Number : 78 Question Id : 25498946279 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
एक बार की बात है, अकबर और बीरबल शिकार पर जा रहे थे। अभी कु छ समय की उन्हें एक हिरण दिखा। जल्दबाजी में तीर निकालते हुए अकबर अपने हाथ पर घाव
लगा बैठा। अब हालात कु छ ऐसे थे की अकबर बहुत दर्द में था और गुस्से में भी।
Restricted/ Unrestricted : Unrestricted
Paragraph Display : Yes
Keyboard Layout : Remington
Show Details Panel : Yes
Show Error Count : Yes
Highlight Correct or Incorrect Words : Yes
Allow Back Space : Yes
Show Back Space Count : Yes

        Hindi ActualGroup Number : 5Group Id : 2549896087Group Maximum Duration : 15Group Minimum Duration : 15Show Attended Group? :

NoEdit Attended Group? : NoBreak time : 0Group Marks : 0         Hindi Typing TestSection Id : 2549899841Section Number : 1Section type :
Typing TestMandatory or Optional : MandatoryNumber of Questions : 1Number of Questions to be attempted : 1Section Marks : 0Display Number Panel :
YesMaximum Instruction Time : 0Sub-Section Number : 1Sub-Section Id : 2549899882Question Shuffling Allowed : NoIs Section Default? : Yes    
Question Number : 79 Question Id : 25498944422 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
मदर टेरेसा एक महान महिला थी और एक महिला मिशन के  रुप में जानी जीती थी। जिसने दुनिया बदलने के  लिये एक बडा कदम उठाया था। वह मेसेडोनिया में पैदा
हुई थी। वह बालिग होते ही कोलकाता में आ गयी थी और गरीब लोगों  की सेवा करने के  अपने जीवन के  मिशन को शुरू कर दिया। मदर टेरेसा ने रोगों  से पीडित
कोलकाता के  गरीब लोगों  की खूब मदद की। मदर टेरेसा ने उनको भरोसा दिलाया कि ये संक्रामक रोग नहीं  है और किसी भी दू सरे  इंसान तक नहीं  पहुंच सकता है।
मानव जाति की सेवा के  लिये वह संत की उपाधि से नवाजी जाएगी जिसकी आधिकारिक जानकारी वेटिकन से हो गई है। मदर टेरेसा एक ऐसी महिला थी जिसने लोगों
को जीवन में असंभव काम करने के  लिये बहुत प्रेरित किया है। वो हमेशा हम सभी के  लिये प्रेरणा रहेंगी। महान मानवता लिये हुए ये दुनिया बेहतर लोगों  से भरी हुई है

है
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लेकिन हरेक को आगे बढने के  लिये एक प्रेरणा की जरुरत होती है। मदर टेरेसा एक अनोखी इंसान थी जो भीड से अलग खडी दिखाई देती थी। मदर टेरेसा का नाम
गों कशे बोजाशियु था लेकिन अपने महान कामों  और जीवन में मिले प्रतिफलों  के  बाद दुनिया उनको नये नाम मदर टेरेसा के  रुप में जानने लगी। वह एक मां की तरह
अपना सारा जीवन गरीब और बीमार लोगों  की सेवा में लगाती थी। वो अपने माता पिता की सबसे छोटी संतान थी। वो अपने माता पिता के  दान परोपकार से बहुत प्रेरित
थी जो हमेशा समाज में जरुरतमंद लोगों  की सहायता करते थे। उनकी मां एक साधारण महिला थी जबकि पिता एक सौदागर थे। मदर टेरेसा एक गटरों  की संत के  रुप
में भी जानी जाती थी। वो पूरी दुनिया की एक महान महिला थी। भारतीय समाज के  जरुरतमंद और गरीब लोगों  के  लिये पूरी ईमानदारी से सेवा कर के  एक मां के  रुप में
सामने आती है। वह अपने समय की संत या अंधेरे  की दुनिया में एक प्रकाश के  रुप में भी जनसाधारण के  जरिये जानी जाती है। एक बार वो अपने किसी दौरे  से लौट रही
थी। वह शोक हो गयी और उनका दिल टू ट गया जब कोलकाता के  एक झोपडी के  लोगों  का दुख देखा। उस घटना ने उनको विचलित कर दिया था और इससे कई रातें
तक वो सो नहीं  पाई थी। मदर टेरेसा ने झोपडी में दुख झेल रहे लोगों  को सुखी करने के  तरीकों  के  बारे  में सोचना शुरु कर दिया था। अपने सामाजिक प्रतिबंधों  के  बारे  में
उनको बखूबी से पता था इसलिये सही पथ समझाना और दिशा के  लिये वह लोगों  को समझाने लगी। मदर टेरेसा को एक संदेश मिला था कि आश्रम छोडो और
जरुरतमंद लोगों  की मदद करो। उसके  बाद वह कभी भी पीछे  नहीं  मुडी और वही से गरीब लोगों  की मदद करने की शुरुआत कर दी थी। मदर टेरेसा ने अपने लिये
साधारण नीले किनारे  वाली सफे द साडी को पहनने के  लिये चुना। शीघ्र ही वह गरीब समुदाय के  पीडित इंसानों  के  लिये मदद को सुलभ कराने के  लिये युवा लडकियों  के
समूह से जुडने लगी। मदर टेरेसा सेविकाओं का एक समूह बनाने की योजना बना रही थी। जो किसी भी माहौल में गरीबों  की सेवा के  लिये हमेशा तैयार रहेगी।
सेविकाओं के  समूह को बाद में मिशनरीज आफ चैरिटी के  रुप में जाना गया था। जो आज भी दुनिया में जाना जाता है।
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